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CHAPTER 2 l Menus
This chapter lists and describes the menu options in 
TriSpectives. You can refer to this chapter for 
information on the main menu as well as the pop-up 
menus that appear throughout TriSpectives.

In this chapter
· Main menu options
· Pop-up menus
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lMain menu options
The main menu bar in the TriSpectives window includes 
the following options. Many of these options display a 
dialog box, wizard, or other prompt. For information on 
these tools, refer to Chapter 3, “Dialog boxes.”

File menu
Use the File menu to manage WorkBook files and 
perform other input/output tasks. In addition to the 
following options, the File menu may include a list of 
WorkBook files. Choose one of these items to open the 
corresponding WorkBook.

· New. Creates a new WorkBook. TriSpectives displays 
the WorkBook Wizard.

· Open. Opens an existing WorkBook file. TriSpectives 
displays the Open dialog box.

· Close. Closes the current WorkBook. If you have made 
changes in the WorkBook, TriSpectives displays a 
prompt to ask if you want to save your changes 
before closing.

· Save. Saves the contents of the current WorkBook. 
TriSpectives saves the WorkBook using its existing 
file name. If the WorkBook is new, TriSpectives 
displays the Save As dialog box to prompt for a 
name.

· Save As. Displays the Save As dialog box, which 
prompts you for the name of a file. Use this 
command the first time you save a WorkBook. You 
can also use it to save a WorkBook under a different 
file name.

· Save All. Saves all open WorkBooks.
· Print Preview. Displays the current document as it will 

appear when you print it. 
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· Print. Displays the Print dialog box. Use the controls on 
this dialog box to print the current document.

· Export Animation. Saves the animated sequence in 
the current document as a software video file. 
TriSpectives displays the Export Animation dialog 
box, which prompts you for a file name and format.

· Export Image. Saves the current document as a 
graphic file. TriSpectives displays the Export Image 
File dialog box, which prompts you for a file name 
and format. TriSpectives supports a variety of 
graphic formats including standards like BMP and 
TIF.

· Export model. Saves the selected model as a database
or program for use with other software. TriSpectives 
displays the Export Model dialog box, which prompts
you for a file name and format. TriSpectives 
supports the file formats for a number of popular 
CAD and 3D design programs. You can also export 
your model as the text of a Visual Basic program.

· Export 2D. Saves the selected 2D drawing in a file for 
use with other software. TriSpectives displays the 
Export 2D Geometry dialog box, which prompts you 
for a file name and format.

· Send. Transfers the current document to another user 
on a network. The Send command activates 
Microsoft Exchange, which lets you specify a 
recipient.

· Exit. Closes TriSpectives and returns to Microsoft 
Windows. If you are using an unsaved WorkBook, 
TriSpectives displays a prompt to ask if you want to 
save before exiting.

Edit menu
Use the commands on this menu to select, copy, and 
perform other editing functions with the contents of a 
3D document. The Edit menu includes the following 
commands:
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· Undo. Reverses the effects of the last operation. For 
instance, choose Undo to restore a deleted shape.

· Redo. Reverses the effects of the Undo command. 
· Cut. Removes the selected object from the document 

and places it on the Windows clipboard.
· Copy. Duplicates the selected object in the document 

and places a copy on the Windows clipboard.
· Paste. Places the contents of the Windows clipboard in 

the current document.
· Clear. Removes the selected object from the display. 
· Select All. Selects all the models or 2D drawings in a 

document. To select models, deactivate the Edit 
IntelliShapes or Edit Surfaces tool if one is active. 

· Deselect All. Returns all selected objects to their 
default state without highlighting, handles, or other 
features of selection.

· Shape Edit Mode. Displays a submenu with choices for
All Shapes, IntelliShapes, and Surfaces and Edges. 
Choose the first option to select and work with entire
models. Use the second to select shapes and the 
third for surfaces, edges, and vertices.

· Object. Edits an object embedded in a page or scene 
using Object Linking and Embedding (OLE). The 
embedded OLE object appears in the application that 
created it.

View menu
Some of the commands on this menu produce 
TriSpectives tools. Other commands change the display.
The View menu includes the following options:

· Toolbars. Displays the Toolbars dialog box. This dialog 
box lets you select and modify the TriSpectives 
toolbars. Check the option for each toolbar you want 
to see.
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· Status bar. Displays or hides the status line at the 
bottom of the TriSpectives window. 

· Ruler. Displays or hides the rulers at the top and along 
the side of the 3D page.

· SmartMotion Editor. Displays the SmartMotion Editor 
window, which has tools that let you control 
animation.

· Catalog Browser. Displays or hides the Catalog 
Browser. The Browser lets you choose a catalog and 
work with its contents.

· WorkBook Browser. Displays the WorkBook Browser, 
which shows the contents of the current WorkBook. 
Use this tool to navigate the contents of the current 
WorkBook and select individual objects.

· Camera. Lets you choose one of the TriSpectives 
camera tools. This command produces a submenu 
with options for each camera. The submenu options 
correspond to the buttons on the Camera toolbar. 
For a list and descriptions of each camera, see “The 
Camera toolbar” in Chapter 1.

· Page Zoom. Displays the Zoom dialog box, which lets 
you change your view of the 3D page. You can select a 
zoom ratio to make the page appear closer or farther 
away.

Insert menu
Use these commands to create new documents, add 
shapes and models, and insert other items into your 
TriSpectives WorkBook. The Insert menu includes the 
following commands:

· Page. Displays the Insert Page dialog box. You can 
create a new page document or insert a page in a 
scene or another page.

· Scene. Displays the Insert Scene dialog box. You can 
create a new scene document or insert a scene in a 
page or another scene.
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· Model from file. Displays the Insert Model File dialog 
box, which lets you import a model created by a CAD
program or other software. Use the dialog box to 
specify the file you want to import. You can also list 
files by their data type.

· IntelliShape. Displays a sub-menu of options for 
creating a custom 3D shape. Choose one of the 
shape creation processes: Extrude, Sweep, Spin, 
Loft.
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· Attachment point. Defines a target point on a shape 
or model where you can attach other objects. 
Choose this option then click the location for the new
attachment point. Objects snap into place when you 
drag them over an attachment point. Also, 
TriSpectives highlights attachment points when 
SmartSnap is active.

· Light. Adds a new light source to the scene. Choose this
option then click the location for the new light. 
TriSpectives displays the Insert Light dialog box 
which lets you choose a directional light or spotlight.

· Object. Inserts data from another program through 
Object Linking and Embedding (OLE). Choose the 
kind of data you want to insert on the Insert Object 
dialog box.

· Text Box. Creates a box on the 3D page where you can
enter and edit text. Choose this option then drag across 
the page to define the boundaries of the text box.

Format menu
The four commands on this menu let you customize the 
documents in your WorkBook and their contents. Each 
command produces a property sheet with a variety of 
options. For information on these property sheets, refer 
to the next chapter.

· Page. Displays the Page Properties sheet.
· Scene. Displays the Scene Properties sheet.
· Shape. Displays the IntelliShape Properties sheet for 

the current shape selection. If the current selection 
is a model, you see the Model Properties sheet.

· Style. Displays the Style Properties sheet for the current
model or surface selection.
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Tools menu
Use this menu to manipulate and analyze the shapes 
and models in a document.

· TriBall. Displays the TriBall over the selected object in 
the page or scene. For more information, see “The 
TriBall tool” in Chapter 1.

· Move From-To. Lets you quickly join and align two 
shapes. The effect is the same as working with the 
Move From-To Tool. For more information, see “The 
Move From-To tool” in Chapter 1.

· Move In-Out. Lets you change the elevation of an 
object on the 3D page. Choose this option, then drag
up to raise the object and down to lower it. The 
effect is the same as working with the Move In-Out 
Tool. For more information, see “The Move In-Out 
tool” in Chapter 1.

· Move Texture. Lets you relocate an image that forms 
the surface texture of a shape or model. Select a 
model or surface with an image texture, choose this 
option, and drag the texture to its new location.

· Move Bumps. Lets you relocate the bumps on the 
surface of a shape or model. Select a model or 
surface with bumps, choose this option, and drag 
the bumps to a new location.

· Move Decal. Lets you relocate a decal image on the 
surface of a shape or model. Select a model or 
surface with a decal image, choose this option, and 
drag the decal to its new location.

· Shape Analysis. Displays the Analysis property sheet, 
which lets you perform a number of analytic 
measurements on the selected object. You can 
measure volume, moments of inertia, and other 
quantities.
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· Options. Displays the Options property sheet. This tool 
lets you set parameters in several categories including 
2D drawing, units, and colors.

Shape menu
These commands work with the 3D objects in a 
document. The Shape menu includes the following 
options:

· Group. Combines two or more models into a group. 
Hold down the Shift key, click each model you want 
in the group, then choose this option. Changes to 
one model affect all group members. You can 
combine groups to form a larger group.

· Ungroup. Breaks the association of models in a group. 
When you choose the tool, the group members 
regain their status as individual objects.

· Bring to Front. Places an embedded scene or page in 
front of other embedded items. This command, and 
the three that follow, work with a single embedded 
scene or page in a stack of similar items. This 
command puts the selected scene or page on top.

· Bring Forward. Moves the selected page or scene up 
one level in a stack. 

· Send to Back. Places the selected scene or page 
behind the other items in a stack.

· Send Backwards. Moves the selected scene or page 
down one level in a stack. 

· Bevel Edges. Displays the Bevel dialog box, which lets 
you round off the edges of a shape or model.

· Move Anchor. Lets you change the location of the 
anchor, the point where a shape joins other shapes. 
Choose this command and then click the location for
the new anchor. 

· Reset Sizebox. Recalculates the dimensions of the 
bounding box around a shape or model. A sizebox 
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retains its original dimensions until you select this 
option. The persistence of the sizebox can be useful 
if you use properties of the sizebox as variables in 
an expression. For instance, you might define the 
height of one sizebox as twice the height of another.
You know that the height of the original won’t 
change until you choose this option.

· Regenerate Model. Assembles a model from its 
component IntelliShapes and displays it in its current
form. This command can be useful when you begin 
working with a model. Initially, TriSpectives displays 
some IntelliShape models in a simplified form for 
performance reasons. If you need access to the 
underlying IntelliShapes, you can use this command.

· Set Operation. Lets you create holes, negative objects 
that remove material instead of adding it. For more 
information, see “Making negative models” in Chapter 
1.

Catalogs menu
A catalog is a collection of resources such as models or 
textures. Use these commands to create new catalogs 
and manage existing ones.

· New. Create a new catalog. TriSpectives displays a 
blank catalog in the Catalog Browser. 

· Open. Opens an existing catalog and displays its 
contents in the browser. Choose the catalog file on 
the Open dialog box.

· Close. Closes the active catalog. Its tab and contents 
disappear from the browser.

· Close All. Closes all open catalogs leaving an empty 
browser.

· Save. Saves the contents of the active catalog. 
TriSpectives uses the existing name for the catalog 
file. If the catalog is new, TriSpectives prompts you 
for a file on the Save As dialog box.
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· Save As. Displays the Save As dialog box. Use this 
option the first time you save a new catalog. You can
also use it to copy the contents of an existing 
catalog into a new file.

· Save All. Saves the contents of all open catalogs.
· Catalog Sets. Displays the Catalog Sets dialog box. 

Use this tool to organize catalogs in groups.

Window menu
These options let you arrange the windows within the 
TriSpectives display. Along with the following 
commands, the Window menu includes an option for 
each open window. Choose the name of the window to 
view its contents.

· New Window. Creates a second view of the current 
WorkBook in a new window. TriSpectives identifies 
each new window with a number in the title bar. For 
example, you might have windows titled My 
Project:1 and My Project:2. Use this command to see
two or more documents at once or to view a model 
from different angles.

· Cascade. Arranges all open windows in a layered stack.
· Tile. Arranges all open windows as adjoining tiles. 
· Arrange Icons. Lines up minimized documents or other

icons in a row along the bottom of the TriSpectives 
window.

Help menu
Use the commands on this menu to learn about 
TriSpectives.

· TriSpectives Help. Starts the TriSpectives online help 
system.
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· Tutorials. Displays online tutorials to help you learn 
about a variety of TriSpectives topics.

· Office Compatible. Displays information about 
Microsoft Office compatibility.

· About TriSpectives. Displays a dialog box that shows 
information about your copy of TriSpectives including 
the version number of the software.
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lPop-up menus
Pop-up menus occur throughout TriSpectives. Most 
objects in the TriSpectives window have a pop-up menu.
Right-click an object to see its menu. 

2D drawing pop-up menu
To see this menu, right-click the 2D drawing grid or one 
of the lines or other objects on the grid. The 2D drawing 
pop-up menu includes the following options:

· Edit Curve. Displays a dialog box for the selected 2D 
item. Select an item on the grid and then choose this
option to see the Line, Circle, Circular Arc, Ellipse, or 
Bezier dialog box. Each dialog box has unique 
options for customizing the appropriate item. 

· Split. Divides the selected 2D item in half. For instance, 
if you select a line and then choose this option, the 
result is two lines with a new control point in the 
middle.

· Delete. Removes the 2D item.
· Snap to. Displays a sub-menu with options to help you 

position the mouse pointer as you drag. TriSpectives
can automatically “snap” the mouse pointer to the 
grid, 2D lines or other geometry, distance 
increments, and angle increments. Choose the 
options you want.

· Show drawing feedback. Displays angle and distance 
measurements as you draw.

· Angle-distance mode. Switches between the two 
drawing styles: the rectilinear mode and the angle-
distance mode. This option has the same effect as 
the Angle-Distance Drag Mode tool, which is 
described in “The 2D drawing tools” in Chapter 1.
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· Offset mode. Displays measurement feedback when 
you drag the endpoints of an existing line or curve.

· Select outline. Selects every line, arc, and other 2D 
object connected to the current one. 

· Use Outline for Construction Only. Indicates that 
part of a 2D drawing does not extend into 3D. For 
example, if you draw a symmetry line for use with 
the Mirror tool, you don’t want it to be part of the 
final 3D shape. Mark it for construction only by 
selecting it and then choosing this option.

· Finish Shape. Completes the process of extending a 
2D cross-section into a 3D shape through extrusion, 
spinning, sweeping, or lofting.

· Cancel. Calls off the 2D drawing process. The grid 
disappears and you return to the scene or page.

· Grid Settings. Displays the Grid Settings dialog box. 
You can change the spacing of the grid lines on this 
dialog box.

· Cross-Section Properties. Displays the Cross-Section 
Properties sheet. Use this tool to modify the anchor, 
sizebox, and other properties of the 2D cross-section.

2D shape pop-up menu
You can use the 2D drawing tools directly on the scene 
or page. The result is a 2D IntelliShape. To see the pop-
up menu for a 2D shape, select it and then right-click it. 
You see the following options:

· Add SmartDimensions. Attaches a SmartDimension to
the 2D shape. TriSpectives displays the Add 
SmartDimensions dialog box.

· Delete. Removes the 2D shape from the scene or page.
· 2D Shape Properties. Displays the 2D Shape 

Properties sheet. Use these options to control the 
anchor, sizebox, position, and other characteristics 
of the shape.
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· Style Properties. Displays the Style Properties sheet. 
Use these options to control the appearance of the 
shape.

2D shape editing pop-up menu
To see this menu, select a 2D IntelliShape on the scene 
or page. Click it again and then right-click it to see the 
following options:

· Edit Curve. Displays a dialog box for the selected 2D 
item. Select an item on the grid and then choose this
option to see the Line, Circular Arc, Ellipse, or Bezier 
dialog box. Each dialog box has unique options for 
customizing the appropriate item. 

· Split. Divides the 2D shape in half. For instance, if you 
use this option with a line, the result is two lines with
a new control point in the middle.

· Delete. Removes the shape from the scene or page. 
· Snap to. Displays a sub-menu with options to help you 

position the mouse pointer as you drag. TriSpectives
can automatically “snap” the mouse pointer to the 
grid, 2D lines or other geometry, distance 
imcrements, and angle increments. Choose the 
options you want.

· Show drawing feedback. Displays angle and distance 
measurements as you draw.

· Angle-distance mode. Switches between the two 
drawing styles: the rectilinear mode and the angle-
distance mode. This option has the same effect as 
the Angle-Distance Drag Mode tool, which is 
described in “The 2D drawing tools” in Chapter 1.

· Offset mode. Displays measurement feedback when 
you drag the endpoints of an existing line or curve.

· Select Outline. Selects every line, arc, and other 2D 
object connected to the current one.
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· Use Outline for Construction Only. Indicates that the
2D shape is for reference or construction of other 
objects only. TriSpectives does not fill the shape with
a solid color.

· 2D Shape Properties. Displays the 2D Shape 
Properties sheet. Use this tool to modify the anchor, 
sizebox, and other properties of the 2D IntelliShape.

· Style Properties. Displays the Style Properties sheet. 
Use these options to control the appearance of the 
shape.

Anchor pop-up menu
To move or reorient an anchor, right-click it to see this 
pop-up menu.

· Move Anchor. Select this option to reposition the 
anchor. Enter new length, width, and height 
distances on the Move Anchor dialog box.

· Spin Anchor. Choose this option to tilt the object. Enter
a new value in the Angle field on the Spin Anchor 
dialog box.

· Flip Anchor. Choose this option to flip the anchor. 
Enter a new angle on the dialog box that appears. 

Annotation Dimension pop-up menu
An annotation dimension is a tool for measuring the 
distance or angle between two locations in the display. 
Although you can use annotation dimensions during the
model-building process, they typically appear as part of 
the final image in a technical illustration or layout. 
When you use an annotation dimension for display 
purposes, it’s important to orient it correctly. The 
dimension needs to appear parallel to the viewing 
plane. If necessary, use the Look At tool to view a 
surface or other feature of the model straight on. After 
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you attach the annotation dimension, choose Horizontal 
or Vertical from its pop-up menu. Use the axis that’s 
parallel to the feature you’re measuring and the viewing
plane.
The annotation dimension pop-up menu contains the 
following options:

· Horizontal Distance. Choose this option to display a 
horizontal dimension and measure the distance 
between two points on a horizontal line.

· Vertical Distance. Select this option to display a 
vertical dimension and measure the distance 
between two points on a vertical line.

· Delete. Use this option to remove the dimension from 
the display.

· Annotation Dimension Properties. Choose this 
option to see the Annotation Properties sheet. For 
details, see “Annotation Properties sheet” in the next 
chapter.

Attachment point pop-up menu
To move or reorient an attachment point, right-click it to
see this pop-up menu.

· Move Attachment Point. Select this option to 
reposition the attachment point. Enter new positions
for each axis on the Move Attachment Point dialog 
box.

· Spin Attachment Point. Choose this option to tilt the 
attachment point. Enter a new value in the Angle 
field on the Spin Attachment Point dialog box.

· Flip Attachment Point. Choose this option to flip the 
attachment point. Enter a new angle on the dialog 
box that appears..

· Delete. Select this option to remove the attachment 
point.
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Catalog pop-up menu
To see the catalog pop-up menu, right-click the catalog 
browser. You can click an icon within the browser or the 
blank area surrounding the icons.
The catalog pop-up menu includes the following items:

· Large Icons. Display the items in the catalog as large 
icons.

· Small Icons. Display the items in the catalog as small 
icons.

· List. Displays the items in the catalog in a list format.
· Change Icon. Selects a new icon for one of the items in

the catalog. Choose an icon file on the Select Icon 
File dialog box. This option is only available if you 
right-click on one of the catalog entries.

· Object. Inserts data from another program as an entry 
in the current catalog. TriSpectives creates the new 
entry through Object Linking and Embedding (OLE). 
Select an object on the Insert Object dialog box.

· Cut. Removes the selected entry from the catalog and 
places it on the clipboard. This option is available 
when you right-click a catalog entry.

· Copy. Duplicates the selected entry from the catalog 
and places it on the clipboard. This option is 
available when you right-click a catalog entry.

· Paste. Places the contents of the clipboard in the 
catalog.

· Delete. Removes the selected entry from the catalog. 
This option is only available if you right-click on one of 
the catalog entries.

Document tab pop-up menu
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To see this pop-up menu, right-click the tab for a 3D 
page or scene. The Document pop-up menu includes 
the following items.

· Rename. Lets you change the name that appears on 
the document’s tab. Enter a new name on the 
Rename Page dialog box.

· Delete. Removes the current document from your 
WorkBook. This option is unavailable if the 
WorkBook has just one document.

· Properties. Displays the Scene Properties or Page 
Properties sheet, depending on the contents of the 
document.

Edge pop-up menu
To see this pop-up menu, select the edge or vertex of a 
shape and right-click it. For information on selecting and
working with edges and vertices, see “Selecting the 
parts of a model” in Chapter 1.
The Edge pop-up menu has a single option, Bevel 
Edges. This option displays the Bevel dialog box which 
lets you round off an edge or vertex.

Embedded Page/Scene pop-up menu
Right-click in an embedded page or scene to see its 
pop-up menu. The menu includes the following options:

· Edit. Opens a new window where you can edit the 
contents of the embedded page or scene.

· Delete. Removes the embedded page or page from the 
document that contains it.

· Embedded Page Properties. Displays the Embedded 
Page or Embedded Scene Properties sheet.

· Style Properties. Displays the Style Properties sheet 
for the embedded page or scene.

Chapter 2: Menus     79



IntelliShape pop-up menu
To see this pop-up menu, select an IntelliShape and 
right-click it. For information on selecting and working 
with IntelliShapes, see “Selecting the parts of a model” 
in Chapter 1.
The IntelliShape pop-up menu includes the following 
options:

· Edit Cross-Section. Displays the 2D cross-section that 
created the IntelliShape. Use the drawing tools to 
modify the cross-section.

· Add SmartDimensions. Displays the Add 
SmartDimensions dialog box. Use these tools to 
measure and set distances and angles. 

· Apply Last. Recreates the selected shape as if you had 
added it to the model last.

· Delete. Removes the selected shape from the scene or 
page.

· IntelliShape Properties. Displays the IntelliShape 
Properties sheet. Use these properties to modify the 
shape through shelling, capping, and other operations.

Light pop-up menu
Right-click a light source to see its pop-up menu. The 
light menu includes the following options:

· Light On. Switches the light on or off. A check by this 
option indicates that the light is on.

· Cast Shadows. Controls whether or not the light casts 
shadows on the objects in a scene or page. A check 
by this option indicates that the light produces 
shadows.

· Delete. Removes the light source and its light from the 
display.
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· Light Properties. Displays the Spot or Directional Light
Properties sheet. Use these properties to adjust the 
color of the light, the softness of its shadows, and other 
settings.

Loft section pop-up menu
Once you create a custom shape through lofting, you 
can edit the individual cross-sections within the shape. 
To work with sections, choose Show Cross-Sections from
the pop-up menu for the loft shape itself. Then right-
click on the button for one section. The loft section pop-
up menu includes these options:

· Edit On Grid. Displays the 2D cross-section on the 
drawing grid. Use the 2D drawing tools to modify the
section and change the form of the resulting 3D 
shape.

· Insert New. Adds one or more cross-sections to the loft
shape. Use the Insert Cross-Sections dialog box to 
specify the number of new sections and their 
position.

· Delete. Removes the selected cross-section from the 
loft shape.

· Cross-Section Properties. Displays the Cross-Section 
Properties sheet for the selected section.

Loft shape pop-up menu
After the lofting process produces a custom 3D shape, 
you often need to modify the results. Use the shape’s 
pop-up menu to edit its cross-sections and other 
features.
The loft shape pop-up menu shares several options with
the standard IntelliShape menu.

· Show Cross-Sections. Reveals the individual 2D 
sections that created the loft shape. Each section 
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has a numbered button. Click the button to see 
handles that let you modify the section. Right-click 
the button to see the section’s pop-up menu.

· Edit Path. Displays the lofting path on the 2D drawing 
grid. This is the path that connects the cross-
sections in the loft shape. Drag the curve handles to 
modify the path.

· Edit Match Points. Lets you change the points that 
connect the cross-sections in the loft shape. The 
match points appear as red dots on the vertices of 
the cross-section. If the section contains multiple 
closed outlines, it only has one match point. To edit 
a match point, drag and drop it on the endpoint of a 
line or curve in the cross-section. Use this technique 
to produce twisted shapes such as a waving banner.

· Add SmartDimensions. Displays the Add 
SmartDimensions dialog box. Use these tools to 
measure and set distances and angles. 

· Apply Last. Recreates the selected shape as if you had 
added it to the model last.

· Delete. Removes the shape from the document.
· IntelliShape Properties. Displays the IntelliShape 

Properties sheet for the shape.

82 TriSpectives Reference Guide



Model pop-up menu
Right-click a model to see its pop-up menu. The model 
menu includes the following features:

· Add SmartDimensions. Displays the Add 
SmartDimensions dialog box. Use these tools to 
measure and set distances and angles. 

· Delete. Removes the selected model from the scene or 
page.

· Analysis. Displays the Analysis property sheet. Use this
tool to perform analytical measurements including 
volume, moments of inertia, and others.

· Statistics. Tallies information about the internal 
structure of the model including the number of 
vertices, faces, edges, and so forth. This information 
goes into a file called Validate.Txt.

· Model Properties. Displays the Model Properties 
sheet, which lets you change the model’s sizebox, 
anchor, and other settings.

· Style Properties. Displays the Style Properties sheet, 
which lets you change the model’s color, transparency, 
and other settings.

Page pop-up menu
Right-click the 3D page to see its pop-up menu. The 
page menu has one option: Page Properties, which 
displays the Page Properties sheet for the page. Use 
these properties to change the size, background, and 
other features of the page.

Right-drag pop-up menu
When you drag a shape or model using the right mouse 
button, this menu appears when you drop the object. 
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Choose one of the following options for relocating the 
object.

· Move Here. Move the object from its original location to
the point where you dropped it. This option produces
the same result as dragging with the left mouse 
button.

· Copy Here. Duplicates the object and places the copy 
at the point where you released the mouse. The 
original reappears at its starting location.

· Link Here. Duplicates the object and links the copy to 
the original. The effect is similar to the Copy Here 
option with the addition of the link. When you 
change one linked object, you affect both.

· Cancel. Returns to the scene or page leaving no effects 
from the right-dragging process.

Scene pop-up menu
Right-click the 3D scene to see its pop-up menu. The 
scene pop-up menu includes the following options:

· Horizontal Split. Creates two viewing panels separated
by a horizontal splitter bar. The bar appears at the 
point where you right-clicked to see the pop-up 
menu. Use multiple views to see a model from two 
or more viewpoints simultaneously.

· Vertical Split. Creates two viewing panels separated 
by a vertical splitter bar.

· Remove View. Deletes a view created by one of the 
previous two options. Right-click in the view you 
want to delete and then choose this option.

· Scene Properties. Displays the Scene Properties 
sheet. Use these properties to change the scene’s 
lighting, background, and other settings.
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SmartDimension pop-up menu
Right-click the value or end point of a SmartDimension 
to see its pop-up menu. The SmartDimension pop-up 
menu includes the following options.
Note: SmartDimensions are a feature of TriSpectives 
Professional.

· Edit This SmartDimension. Displays the Edit 
SmartDimension dialog box. You can enter a new 
distance or angle value for the SmartDimension and 
lock it in place.

· Edit All SmartDimensions. Displays a table that 
shows the angle or distance values for all 
SmartDimensions on a particular shape. This table 
makes it easy to edit multiple values at once.

· Delete SmartDimension. Removes the 
SmartDimension from the shape.

Surface pop-up menu
To see the pop-up menu for one surface of a model or 
IntelliShape, select the surface and then right-click it. 
The surface pop-up menu includes these commands:

· Bevel Edges. Displays the Bevel dialog box which lets 
you round off the edges of the surface.

· Style Properties. Displays the Surface Style Properties
sheet. Use these properties to modify the color, 
bumpiness, transparency, and other features of the 
surface.

Value pop-up menu
When you position an object using the TriBall, you see a
line or arc that indicates the current distance or angle of

Chapter 2: Menus     85



rotation. The indicator contains a value that changes as 
you drag. Right-click this value to edit it. 
The value menu has a single option: Edit Value. When 
you choose this option, you can enter a new angle or 
distance measurement on the dialog box that appears.

WorkBook Browser item pop-up 
menu
This pop-up menu appears when you right-click one of 
the items in the hierarchical display of the WorkBook 
Browser. The options on the menu depend on the item 
you click. For instance, the Apply Last option is available
if you click a shape, but not if you click a document.
The WorkBook Browser pop-up menu includes these 
commands:

· Select. Makes a shape, model, or other item the current
selection. For example, you can select a shape by 
right-clicking its entry in the WorkBook Browser and 
choosing this option. When you return to the scene 
or page, the shape is highlighted.

· Apply Last. Recreates an IntelliShape as if it were the 
last one added to a model. 

· Delete. Removes an item from the WorkBook Browser 
and the display.

· Properties. Shows the appropriate property sheet. For 
instance, you can display the property sheet for a 3D
scene by right-clicking its entry in the WorkBook 
Browser and choosing this option.
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